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1. GENERAL INFORMATION

The MKN5610 is a satellite receiver for the GPS (Global Positioning System). It contains
components to download satellite signals, compute positions from satellite ranges, and output
data in a usable ASCII format according to the standard GPS sentence protocols defined by the
National Marine Electronics Association (NMEA). This manual will provide all of the information
necessary to operate the MKN5610.

1.1 Introduction

This manual contains information for the setup and operation of the following Mobile Knowledge
products:

 MKN5610 GPS Module

 MKN5610 Evaluation Kit

 ADK VIEW GPS Evaluation Software for PCs

1.2 Hardware Specification

MECHANICAL

Dimensions 80 mm x 40 mm x 9.4 mm

3.15" x 1.57" x 0.37"

Weight 25 g, 0.9 oz

Table 1.1 Mechanical Dimensions

Figure 1.1 Physical Dimensions
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1.3 Block Diagram & Header Information

Figure 1.2 Block Diagram

Header Specification Function

H2 5 x 2 pin header, 1.27mm spacing,
M503900522 HARWIN

Basic GPS interface: RS232 NMEA and RTCA, HCMOS
1PPS and LOCK indicator

H3 5 x 2 pin header, 1.27mm spacing,
M503900522 HARWIN

Test and programming interface

H4 5 x 2 pin header, 1.27mm spacing,
M503900522 HARWIN

Programmed IO interface–A
Eight uncommitted TTL IO signals

H5 5 x 2 pin header, 1.27mm spacing,
M503900522 HARWIN

Programmed IO interface–B
Eight pre–allocated TTL IO signals

Table 1.2 Header Functions

Pin # Signal Description Typical Usage*

1 VBAT Backup battery power in, 3.3–5.0VDC

2 5V Power in, 5 VDC 5%

3 GND Digital ground

4 RTx1 RS232 output Test report output

5 RRx1 RS232 input RTCM input

6 PA7 Uncommitted programmable IO 1PPS output pulse

7 PA6 Uncommitted programmable IO LOCK output(satellite or DGPS), active high
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8 RTx0 RS232 output NMEA output

9 RRx0 RS232 input NMEA input

10 -RST External RESET (47K pull UP on 5610)

* Usage depends on firmware

Table 1.3 Header H2: Basic Functions

Pin # Signal In/Out Description

1 –TRST in Test logic reset

2 TCK in Test clock

3 WDE in Watch dog enable. Ground to disable WDT in GP6

4 TMS in Test mode select

5 –RST in Reset. Ground to reset GP6

6 TDI in Test data input

7 TGO out Trigger output from DCU

8 TDO out Test data output

9 TGIN in Trigger input to DCU

10 GND Digital Ground

Table 1.4 Header H3: Test and Programming

Pin # Signal Description Usage

1 GND Digital ground

2 INT0 GP6 external interrupt 0 Uncommitted (Input)

3 PA0 GP6 programmed IO: PIO00 Short to PIO01 to force test mode on reset

4 PA1 GP6 programmed IO: PIO01 Short to PIO00 to force test mode on reset

5 PA2 GP6 programmed IO: PIO02 Uncommitted

6 PA3 GP6 programmed IO: PIO03 Uncommitted

7 PA4 GP6 programmed IO: PIO04 Uncommitted

8 PA5 GP6 programmed IO: PIO05 Uncommitted

9 PA6 GP6 programmed IO: PIO06 Satellite lock output, asserted high

10 PA7 GP6 programmed IO: PIO07 1PPS output pulse (not implemented)

Table 1.5 Header H4: PA Bus

Pin # Signal Description Usage

1 GND Digital ground

2 INT1 GP6 external interrupt 1 Uncommitted (input)

3 PB0 GP6 programmed IO: PIO10 Uncommitted

4 PB1 GP6 programmed IO: PIO11 Uncommitted

5 PB2 GP6 programmed IO: PIO12 Uncommitted

6 PB3 GP6 programmed IO: PIO13 Uncommitted

7 PB4 GP6 programmed IO: PIO14 Uncommitted

8 PB5 GP6 programmed IO: PIO15 Uncommitted
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9 PB6 GP6 programmed IO: PIO16 Uncommitted

10 PB7 GP6 programmed IO: PIO17 Uncommitted

Table 1.6 Header H5: PB Bus

1.4 Electrical Specification

Pin Description Min Typ Max

H2-2 Vcc 4.5 V 5 V 5.5 V

Input current (without Antenna) 145mA

H2-1 Vbat 1.4 V 3.3 V 3.6 V

Operational power consumption 50µW

H4, H5 PAx, PBx, output logic 1 2.4 V 3.3 V

PAx, PBx, output logic 0 0 V 0.4 V

H4, H5 PAx, PBx, INTx

Input logic 1

2.0 V 3.8 V

Input logic 0 -0.5 V 0.8 V

Input current -10 µA 10 µA

Ext. Ant. Vant (extern Antenna Power Supply) 6 V

Input Current 50 mA

29 Not Reset 2.4 V 3.8 V

H2–5,9 RX0, RX1, RS232 option, Logic 0 -15 V 0.8 V

RX0, RX1, RS232 option, Logic 1 2 V 15 V

H2–4,8 TX0, TX1, RS232 option, Logic 0 -5.8 V -5 V

TX0, TX1, RS232 option, Logic 1 5 V 5.8 V

Table 1.7 Electrical Specifications

1.5 Performance Specifications
Feature Specification

Channels 12 parallel tracking

Frequency L1 - 1575 MHz

Position Accuracy

Stand alone 15 m CEP

Differential 2-3 m CEP

Time To First Fix

Cold 90s

Warm < 30 s

Reacquisition 1 s

Table 1.8 Performance Specifications
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1.6 Environmental Specifications
Characteristic Specification

Operating Temperature -40°C to +85°C

Storage Temperature -40°C to +85°C

Humidity 95% max. (non-condensing)

Dynamics, Velocity 514 m/s

Table 1.9 Environmental Specifications

1.7 Default Configuration Settings

Parameter Default

NMEA Message Strings GGA, VTG, GSA, GSV

NMEA Message Period 1s

Baud Rate - Port 0 4,800

Baud Rate - Port 1 4,800

Elevation Mask 10

Satellite Mask None

Fix Mode Automatic

Differential Mode Auto

Dilution of Precision 6

Debug Off

Table 1.10 Default GPS Configuration Settings

1.8 Connector Part Numbers and Vendors

Purpose Vendor Part Number

Mating header Harwin M50–3110522

Nylon standoffs 3M 3C110–2001HB

Mating header on ribbon cable Richco MPSM–4–01 (0.250”)

Vendor Phone Number Web Site

Harwin +1 (812) 285–0055 www.harwin.com

3M +1 (800) 225–5373 * www.3M.com/interconnects

Richco +1 (773)–539 4060 www.richcoplas.com

Samtec +1 (812) 944–6733 www.samtec.com

* In North America Only

Table 1.11 Part Numbers and Vendors
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2. OPERATION

2.1 Getting Started

This section will help you get started quickly whether you wish to carry out differential GPS
positioning, or simply output NMEA strings to a terminal program. Subsequent sections contain
additional information related to output messages and configuration settings.

2.2 Evaluation Kit

If you have purchased the MKN5610 with the Evaluation Kit, your Evaluation Kit will include the
following components:

 MKN7510 Evaluation Kit Interface Board

 MKN5610 GPS Module

 MKN3910 L1 GPS Antenna

 AC Power Adapter (120AC to 12VDC)

 RS-232 Data Cable

 Documentation and Software CD

2.3 Handling Precautions

The MKN5610 contains components that are sensitive to electrostatic discharge. Please handle
with care. Use caution when using the device to not bend or displace the surface mount antenna
cable.

2.4 System Setup

The MKN5610 is a self contained GPS receiver designed to fit into nylon standoffs for mounting
into a hardware device, communicating with the primary (H2) header. See also the Evaluation kit
section of this manual if your module is supplied with the kit.

The antenna connection on the MKN5610 is an SMA jack. The connection required for the
antenna cable is an SMA plug. The antenna power supply is 5V, 50mA max. (supplied by the
module).

2.5 Port Configuration

The default port settings for NMEA data output are PORT 0, communications 4800, 8, N, 1. The
receiver is configured to output a version string at power up, and subsequent NMEA data at a 1
Hz data rate. PORT 1 is configured for RTCM SC-104 differential GPS input at communications
4800, 8, N, 1. Port settings are configurable –please see section 3: Communication for more
information on configuring port settings.

2.6 Satellite Tracking

When the MKN5610 is powered up for the first time, it does not contain any satellite almanac or
ephemeris data in onboard memory, nor time or previous position information. It will begin
searching for satellites from this condition, called a cold start, by cycling through all 32 available
satellite PRN numbers. Once satellites are tracked, the MKN5610 will automatically synchronize
it’s onboard clock with GPS time, and begin downloading satellite almanac and ephemeris 
information. Approximately 15 minutes of continuous data are required to download a full
almanac set for all available satellites.  After this time, the receiver will hold onto it’s precise time 
and almanac information after power down, provided it is supplied with power from the battery
backup. This condition is known as a warm start. Removing the backup battery will clear the
memory and satellite acquisition will be from a “cold start” once power is returned.  Time to first fix 
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(TTFF) for a cold start is approximately 1.5 minutes. For a warm start, TTFF is typically better
than 30 seconds.
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3. COMMUNICATIONS

All messages to and from the MKN5610 are configured in accordance with the recommended
NMEA message protocol standard, Version 2.30.

3.1 NMEA Message Format

All messages conform to a general standard and are formatted similar to NMEA sentences. As a
general rule messages sent from the host to the MKN5610 will have a standard response. All
messages will be ASCII except where indicated.

3.1.1 General Format

The general format for NMEA messages is:

 $<Vendor><Message >{[Parameter],}[*Checksum] <CR> <LF>

 <>Angled brackets are compulsory parameters.

 [] Square brackets are optional parameters.

 {} Curly brackets signify a sequence.

<Vendor> Identifies the message format for NMEA standard messages. The Mobile Knowledge
proprietary vendor tag is “PSGM”. ST proprietary vendor flag is “PSTM” and the NMEA standard 
is “GP”.

<Command/Query> Identifies the message format for proprietary request messages from the
host to the GPS MKN5610.

<Parameters> Comma separated parameters specific to the request, response or data message.
There are never any spaces between parameters.

<Response> Identify the message format for proprietary or NMEA standard messages from the
MKN5610 to the host in response to a request.

<Data> Identifies unsolicited data messages from the GPS MKN5610.

<Result> Indicates the status of the response message. A value of 0 indicates success and all
other values identify an error.

The proprietary Mobile Knowledge ADK NMEA sentences can be divided into

 Commands

 Queries

 Data messages

Requests are messages sent from a host computer or user to the GPS MKN5610. Responses
are messages that are sent from the GPS MKN5610 to the host computer or user in response to
a request message. Data messages are periodic messages automatically sent from the GPS
MKN5610 to the host, for example the NMEA RMC message.

 $PSGM, <Command/Query>, {[Parameter],} [*Checksum]

 $PSGM, <Response>, <Result> {[Parameters],} [*Checksum]

 $GP<Data>, {[Parameters],} [*Checksum]

[*Checksum] A 1-byte checksum generated by XORing every byte of the sentence together
(excluding the * immediately preceding the checksum). In request messages this parameter is
optional.
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3.2 Standard NMEA Data Messages

These standard NMEA messages comply with NMEA Revision V2.30. They are fully defined in
this section. They are available through Port 0 of the MKN5610.

 GGA

 GSA

 GSV

 RMC

 VTG

3.2.1 GGA –GPS Fix Data

Message: $GPGGA, <UTC-Time>, <Latitude>, <Latitude-hemisphere>, <Longitude>,
<Longitude-hemisphere>, <GPS-Quality>, <GPS-Quality>, <Satellites>, <Horizontal-dil>,
<Height>, M, <Geoidal-height>, M, <DGPS-age>, <DGPS-station> [*Checksum]

<UTC-Time> UTC time of fix hhmmss.

<Latitude> ddmm.mmmm

<Latitude-hemisphere> N or S

<Longitude> dddmm.mmmm

<Longitude-hemisphere> E or W

<GPS-Quality> 0 = No fix, 1 = Non-differential fix, 2 = differential fix (DGPS)

<Satellites> Number of satellites in use, 00 to 12.

<Horizontal-dil> Horizontal dilution of precision, 0.5 to 99.9

<Height> -9999.9 to 99999.9 meters relative to mean sea level

<Geoidal-height> -000.9 to 9999.9 meters.

<DGPS-age> Seconds since last valid RTCM update, null field when DGPS not used.

<DGPS-station> Differential reference station ID, 0000 to 1023.

3.2.2 GSA –DOP and Active Satellites

Message: $GPGSA, <Fix-mode>, <Fix-type>, {<PRN>,} <Position-dil>, <Horizontal>, <Vertical -
dil> [*Checksum]

<Fix-mode> Mode M = manual, A = automatic.

<Fix-type> 1 = fix not available, 2 = 2 dimensional fix, 3 = 3dimensional fix.

<PRN> A list of up to 12 satellite PRN numbers used in solution each with a value of 01 to 32.

<Position-dil> Position dilution of precision, 0.5 to 99.9

<Horizontal-dil> Horizontal dilution of precision, 0.5 to 99.9

<Vertical-dil> Vertical dilution of precision, 0.5 to 99.9

3.2.3 GSV –Satellites In View

Message: $GPGSV, <Total-sentences>, <Current-sentence>, <Satellites> {<PRN>, <Elevation>,
<Azimuth>, <SNR>} [*Checksum]

<Total-sentences> Total number of GSV sentences to be transmitted.

<Current-sentence> Number of the current GSV sentence.



MKN5610 GPS Module

RM-2002-04-25.00 Page 15 of 34

<Satellites> Total number of satellites in view.

<PRN> Satellite PRN number.

<Elevation> Satellite elevation, 00 to 90 degrees.

<Azimuth> Satellite azimuth, 000 to 359 degrees.

<SNR> Signal to noise ratio, 00 to 99 dB.

3.2.4 RMC –Recommended Minimum Specific GPS/Transit Data

Message: $GPRMC, <UTC-time>, <Status>, <Latitude>, <Latitude-hemisphere>, <Longitude>,
<Longitude-hemisphere>, <Speed-knots>, <Course>, <UTC-date>, <Magnetic-variation>,
<Magnetic-variation-sense>, <Mode> [*Checksum]

<UTC-time> UTC time of fix ‘hhmmss’.

<Status> Status, A = Valid position, V = NAV receiver warning.

<Latitude> ddmm.mmmm

<Latitude-hemisphere> N or S

<Longitude> dddmm.mmmm

<Longitude-hemisphere> E or W

<Speed-knots> 000.0 to 999.9

<Course> 000.0 to 359.9

<UTC-date> ddmmyy

<Magnetic-variation> 000.0 to 180.0

<Magnetic-variation-sense> E or W

<Mode> A=Autonomous, D=Differential, E=Estimated, N=Data not valid

3.2.5 GLL –Geographic Position –Latitude/Longitude

Message: $GPGLL, <Latitude>, <Latitude-hemisphere>, <Longitude>, <Longitude-hemisphere>,
<UTC-time>, <Status>, <Mode> [*Checksum]

<Latitude> ddmm.mmmm

<Latitude-hemisphere> N or S

<Longitude> dddmm.mmmm

<Longitude-hemisphere> E or W

<UTC-Time> UTC time of fix hhmmss

<Status> Status, A = Valid position, V = NAV receiver warning

<Mode> A=Autonomous, D=Differential, E=Estimated, N=Data not valid

3.2.6 VTG –Track Made Good and Ground Speed

Message: $GPVTG, <Course>, T, <Magnetic-course>, M, <Speed-knots>, N, <Speed-kph>, K,
<Mode> [*Checksum]

<Course> True course over ground, 000 to 359 degrees.

<Magnetic-course> Magnetic course over ground, 000 to 359 degrees.

<Speed-knots> Speed over ground 000.0 to 999.9 knots.

<Speed-kph> Speed over ground, 000.0 to 1851.8 kilometres per hour.
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<Mode> Mode indicator, A = Autonomous, D = Differential, E = Estimated, N = Data not valid.

3.2.7 ZDA –Time and Date

Message: $GPZDA, <UTC-time>, <UTC-day>, <UTC-month>, <UTC-year>, <Local Zone Hours>,
<Local Zone Minutes>[*Checksum]

<UTC-Time> UTC time of fix hhmmss

<UTC-day> UTC day of fix 1 to 31

<UTC-month> UTC month of fix 1 to 12

<UTC-year> UTC year of fix

<Local Zone Hours> Local time zone hours (not used)

<Local Zone Minutes> Local time zone minutes (not used)

3.3 Non-Standard NMEA Data Messages

3.3.1 RAW –Unfiltered Position Data

Message: $GPRAW, <UTC-time>, <Latitude>, <Latitude-hemisphere>, <Longitude>, <Longitude-
hemisphere>, <Height>, <Vel-north>, <Vel-east>, <Vel-vertical>[*Checksum]

<UTC-Time> UTC time of fix hhmmss.sss

<Latitude> ddmm.mmmmmm

<Latitude-hemisphere> N or S

<Longitude> dddmm.mmmmmm

<Longitude-hemisphere> E or W

<Height> -9999.9 to 99999.9 meters relative to mean sea level

<Vel-north> Velocity in north direction (m/s)

<Vel-east> Velocity in east direction (m/s)

<Vel-vertical> Velocity in vertical direction (m/s)

3.3.2 FIL –Filtered Position Data

Message: $GPFIL, <UTC-time>, <Latitude>, <Latitude-hemisphere>, <Longitude>, <Longitude-
hemisphere>, <Height>, <Vel-north>, <Vel-east>, <Vel-vertical>[*Checksum]

<UTC-Time> UTC time of fix hhmmss.sss

<Latitude> ddmm.mmmm

<Latitude-hemisphere> N or S

<Longitude> dddmm.mmmm

<Longitude-hemisphere> E or W

<Height> -9999.9 to 99999.9 meters relative to mean sea level

<Vel-north> Velocity in north direction (m/s)

<Vel-east> Velocity in east direction (m/s)

<Vel-vertical> Velocity in vertical direction (m/s)
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3.4 Command Messages

3.4.1 Activate NMEA Messages –Batch Format

To activate or deactivate all of these messages including baud rate in a single configuration
message, the following NMEA formatted command must be issued to the MKN5610 from a PC
Terminal utility:

$PSTMNMEA,<RMC>,<GGA>,<VTG>,<GSA>,<GSV>,<baud rate>

Where a 1 for each field sets the parameter to on/active, and 0 sets the parameter to off/deactive.

Example 1

To turn on only the GGA and VTG strings at 9600 baud, and to store the configuration for
subsequent power-up:

$PSTMNMEA,0,1,1,0,0,9600, <store> <CR><LF>

Example 2

To turn on only the GSA and GSV strings on at 19,200 baud, and to not store the
configuration for subsequent power-up:

$PSTMNMEA,0,0,0,1,1,19200,0<CR><LF>

3.4.2 Activate NMEA Messages - Individual Format

To toggle individual NMEA messages on or off, the following commands can be issued to the
MKN5610 Evaluation Kit from a PC terminal utility:

 $PSTMRMC<CR><LF>

 $PSTMGGA<CR><LF>

 $PSTMVTG<CR><LF>

 $PSTMGSA<CR><LF>

 $PSTMGSV<CR><LF>

3.4.3 Set Baud Rates

By default the MKN5610 outputs its NMEA strings, and accepts NMEA formatted command
messages from an external terminal at 4800bd-8-N-1. To switch to another baud rate between 0
and 38,400 bd, issue the following proprietary NMEA formatted command:

$PSTMBAUD,<baud rate><CR><LF>

Where the Baud rate = 1200, 2400, 4800, 9600, 19,200, 38,400 bd.

3.4.4 Initialize GPS Fix Parameters

To speed the time to first fix for the MKN5610 when starting the unit for the first time, you can
upload a current time, date, and position to the receiver. If the MKN5610 has a current almanac,
the TTFF should be within 30 seconds vs. 90 seconds for a cold start.

Command: $PSGM, INIT, <Latitude>, <Longitude>, <Height>, <Day>, <Month>, <Year>,
<Hours>, <Minutes>, <Seconds> [*Checksum]

Response: $PSGM, INIT, <Result> [*Checksum]

3.4.5 Initialize Center Frequency

The MKN5610 utilizes a crystal oscillator as a frequency reference for the embedded DSP
processor. This command allows you to specify a known frequency offset to the default crystal
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value to ensure proper receiver operation. Center Frequency is a factory configurable parameter
and should not be performed in the field.

Command: $PSTM, FREQ, <Center frequency> [*Checksum]

Response: $PSTM, FREQ, <Result> [*Checksum]

3.4.6 Set NMEA Message Output Period

You may specify the rate at which the MKN5610 outputs the active NMEA Data messages using
this command.

Command: $PSGM, PERIOD, <Period> [*Checksum]

Response: $PSGM, PERIOD, <Result> [*Checksum]

Requests the GPS MKN5610 to output NMEA sentences every <time> seconds. Where time is
between 1 and 600 seconds.

3.4.7 Configure One-Pulse Per Second

The MKN5610 provides an optional 1PPS timing signal for network synchronization and other
applications. This command allows you to configure the pulse duration of this timing reference.

Command: $PSGM, PPS, <Enable>, <Length> [*Checksum]

Response: $PSGM, PPS, <Result> [*Checksum]

<Enable> Enable the one pulse per second timing feature. A value of 1 enables 1PPS, and a 0
disables 1PPS.

<Length> Sets the length of the pulse in milliseconds from 1 to 999ms.

3.4.8 Set Differential GPS Operating Mode

The MKN5610 will accept an external DGPS signal input to improve the accuracy of the GPS
position computed by the receiver. This command allows you to specify whether the unit should
output GPS messages only when a differential signal is available, only when no DGPS signal is
available, or in either situation.

Command: $PSGM, DGPS, <Mode> [*Checksum]

Response: $PSGM, DGPS, <Result> [*Checksum]

<Mode> Sets the differential mode to differential fix only, automatic, or no

differential fix. DIFF_ONLY = 0, AUTO_DIFF = 1, NO_DIFF = 2.

3.4.9 Set Fix Mode

The MKN5610 can be configured to output a position message in either a 2D or a 3D format.
When 2D is specified, the MKN5610 holds its elevation constant and uses all available satellites
to compute a best estimate of the Latitude and Longitude. 2D Fix Mode is most typically used in
marine applications though it can offer some advantages in urban centers where obstructions are
frequent. Setting the MKN5610 to Auto Mode will allow a 2D position to be computed with only 3
satellites. When four or more satellites are available, a 3D position is computed.

Command: $PSGM, FIX, <Mode>, [*Checksum]

Response: $PSGM, FIX, <Result> [*Checksum]

<Mode> Sets the MKN5610s satellite-tracking mode to 2-dimensional, 3-dimensional or
automatic. A value of 1 is for automatic, 2 for 2D and 3 for 3D.
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3.4.10 Set Dilution of Precision

The MKN allows you to specify a maximum Dilution of Precision. In the event that the DOP is
greater than these specified thresholds, the receiver will not output a position.

Command: $PSGM, DOP, <DIM>, <PDOP>, <HDOP>, <VDOP>[*Checksum]

Response: $PSGM, DOP, <Result> [*Checksum]

<DIM> Set dilution of precision for calculating 3-dimensional or 2-dimensional fixes. Valid values
are, 2D = 2, 3D = 3.

<PDOP> Maximum PDOP, range is 1.0 to 6.0.

<HDOP> Maximum HDOP, range is 1.0 to 6.0.

<VDOP> Maximum VDOP, range is 1.0 to 6.0.

3.4.11 Set Elevation Mask Angle

The MKN5610 allows you to specify a minimum satellite elevation mask. Satellites below this
mask angle will not be employed in the position computation.

Command: $PSGM, ELEV, <Angle> [*Checksum]

Response: $PSGM, ELEV, <Result> [*Checksum]

<Angle> The minimum angle in degrees at which the GPS MKN5610 will track a

satellite. This angle should be between 0 and 30 degrees.

3.4.12 Set Satellite Mask

The MKN5610 allows you to deactivate certain satellites that may be known to broadcast
erroneous information. In the event that you chose to deactivate a satellite, that satellite will
become active again on subsequent power-up.

Command: $PSGM, SAT, <Satellite-mask> [*Checksum]

Response: $PSGM, SAT, <Result> [*Checksum]

3.4.13 Set Debug

The MKN5610 offers a proprietary debug message used by Mobile Knowledge Engineers and
Technical Support staff to diagnose problems in the field.

Command: $PSGM, DBG, <Enable> [*Checksum]

Response: $PSGM, DBG, <Result> [*Checksum]

<Enable> Enables or disables MKN5610 debugging. A value of 0 disables debugging

and a value of 1 enables debugging.

3.4.14 Set Serial Port

This command allows you to specify the baud rate with which you wish to communicate with the
MKN5610.

Command: $PSGM, BAUD, <Port>, <Speed>, <Data-bits>, <Parity>, <Stop-bits>[*Checksum]

Response: $PSGM, BAUD, <Result> [*Checksum]

<Port> Is the port number (0 or 1).

<Speed> The speed in bits per second, which the port should be set between 300 and 38400
bps.

<Data bits> The number of data bits (normally 8)
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<Parity> The parity (normally set to no parity), none, odd or even 0, 1 or 2

<Stop bits> The number of stop bits (normally set to 1), 1 or 2 stop bits.

3.4.15 Sleep

Instructs GPS MKN5610 to sleep for a period of time. This command is useful for users who wish
to control the low-power behaviour of the device with an external controller via the serial port.

Command: $PSGM, SLEEP, <Duration> [*Checksum]

Response: None

<Duration> The time period in seconds that the MKN5610 should power down for from 1 to 9999
seconds.

3.4.16 Reboot

Instructs the GPS MKN5610 to perform a reboot immediately.

Command: $PSGM, REBOOT [,<Reason>] [*Checksum]

Response: None

<Reason> Optional reason for MKN5610 reboot, BOOT_NORMAL=0, BOOT_DOWNLOAD=1.

3.4.17 Clear Ephemeris

Clears the satellite ephemeris information stored in battery-backed memory. Subsequent reboots
will result in longer TTFF as Ephemeris information is required to achieve the most rapid
acquisition of satellites and subsequent position fixes.

Command: $PSGM, CLREPHS [*Checksum]

Response: $PSGM, CLREPHS, <Result> [*Checksum]

3.4.18 Clear Almanacs

Clears the satellite almanac information stored in battery-backed memory. Subsequent reboots
will result in a Cold-start TTFF as Almanac information is required to acquire satellites in the GPS
constellation. It can take up to 15 minutes to download an almanac once lock on the first satellite
following a cold-start is achieved.

Command: $PSGM, CLRALMS [*Checksum]

Response: $PSGM, CLRALMS, <Result> [*Checksum]

3.4.19 Set Almanac

You may upload a current almanac for a specified satellite to the MKN5610 in order to accelerate
time to first fix.

Command: $PSGM, ALMSET, <Satellite>, <Week>, <Toa>, <E>, <Delta_i>, <Omega_dot>,
<Root_a>, <Omega_zero>, <Perigee>, <Mean anomaly>, <Af0>, <Af1>, <Health>, <Available>,
<Save> [*Checksum]

Response: $PSGM, ALMSET, <Result>[*Checksum]

<Satellite> is the satellite’s PRN (8-bit in decimal)

<Source> selects the current active almanac, or the almanac stored in flash. 0 indicates RAM, 1
indicates FLASH.

<Week> the week number for the epoch (16-bit in HEX)

<Toa> time of acquisition (8-bit in HEX)
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<E> eccentricity (16-bit in HEX)

<Delta_i> rate of inclination angle (16-bit in HEX)

<Omega_dot> rate of right ascension (16-bit in HEX)

<Root_a> square-root of semi-major axis (24-bit in HEX)

<Omega_zero> longitude of ascending node of orbit plane at weekly epoch (24-bit in HEX)

<Perigee> argument of perigee (24-bit in HEX)

<Mean anomaly> mean anomaly at reference time (24-bit in HEX)

<Af0> constant clock correction (11-bit in HEX)

<Af1> first order clock correction (11-bit in HEX)

<Health> contains 1 if satellite is unhealthy, else 0 (1-bit in HEX)

<Available> contains 1 if available, else 0 (1-bit in HEX)

Write almanac data into RAM for a particular satellite.

3.4.20 Save Almanacs

Once an almanac has been uploaded/downloaded to the MKN5610 either through the serial port
or over the satellite channel, may store this into Flash memory so that it is available for following
subsequent power disruptions.

Command: $PSGM, ALMSAVE [*Checksum]

Response: $PSGM, ALMSAVE, <Result> [*Checksum]

Save the current almanacs stored in RAM to the flash.

3.4.21 Save Non-Volatile Configuration Information

You may store all configuration parameters associated with the MKN5610 into Flash memory so
that the receiver’s configuration is maintained through power disruptions.

Command: $PSGM, NVSAVE [*Checksum]

Response: $PSGM, NVSAVE, <Result> [*Checksum]

Saves the current NMEA configuration into Flash memory.

3.5 Queries

3.5.1 Get Initialization Information

Returns initialization parameters (if available)

Query: $PSGM, GETINIT [*Checksum]

Response: $PSGM, GETINIT, <Result> [, <Latitude>, <Longitude>, <Height>, <Day>, <Month>,
<Year>, <Hours>, <Minutes>, <Seconds>, <Center frequency>[*Checksum]

3.5.2 Get Version Information

Returns receiver firmware version and date of update

Query: $PSGM, VERSION [*Checksum]

Response: $PSGM, VERSION, <Result> [, <Version String>] [*Checksum]

<Version-String> The version number of the GPS MKN5610.
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3.5.3 Get Non-Volatile Configuration Information

Returns MKN5610 GPS configuration information

Query: $PSGM, GETCONF [*Checksum]

Response: $PSGM, GETCONF, <Result> [, <Sentences>, <Period> <PPS>, <DGPS-Mode>,
<Debug>, <Baud-0>, <Baud-1>] [*Checksum]

<Period> The frequency in seconds to transmit the requested NMEA sentences.

<PPS> <PPS-State> <Pulse-Length>.

<DGPS-Mode> Differential GPS mode. DIFF_ONLY = 0, AUTO_DIFF = 1, NO_DIFF = 2

<GPS-Mode> Set to 1 for auto, 2 for 2D and 3 for 3D.

<Debug> A value of 1 indicates debugging is enabled, 0 indicates debugging is disabled.

<Baud-n> <baud>, <data-bits>, <stop-bits>,

3.5.4 Get Position Parameters

Returns satellite position parameters

Query: $PSGM, GETPP [*Checksum]

Response: $PSGM, GETPP, <Result> [, <2D-PDOP>, <2D-HDOP>, <2D-VDOP>, <3D-PDOP>,
<3D-HDOP>, <3D-VDOP>, <Angle>, <Satellite-mask>] [*Checksum]

3.5.5 Get Almanac

Returns current available satellite almanac

Query: $PSGM, GETALM, <Satellite> [*Checksum]

Response: $PSGM, GETALM, <Result> [ , <Satellite>, <Week>, <Toa>, <E>, <Delta_i>,
<Omega_dot>, <Root_a>, <Omega_zero>, <Perigee>, <Mean anomaly>, <Af0>, <Af1>,
<Health>, <Available> ] [*Checksum]

<Satellite> is the satellite’s PRN (8-bit in decimal)

<Week> the week number for the epoch (16-bit in HEX)

<Toa> time of acquisition (8-bit in HEX)

<E> eccentricity (16-bit in HEX)

<Delta_i> rate of inclination angle (16-bit in HEX)

<Omega_dot> rate of right ascension (16-bit in HEX)

<Root_a> square-root of semi-major axis (24-bit in HEX)

<Omega_zero> longitude of ascending node of orbit plane at weekly epoch (24-bit in HEX)

<Perigee> argument of perigee (24-bit in HEX)

<Mean anomaly> mean anomaly at reference time (24-bit in HEX)

<Af0> constant clock correction (11-bit in HEX)

<Af1> first order clock correction (11-bit in HEX)

<Health> contains 1 if satellite is unhealthy, else 0 (1-bit in HEX)

<Available> contains 1 if available, else 0 (1-bit in HEX)
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4. EVALUATION KIT

Figure 4.1 Evaluation Kit

4.1 Introduction

The Evaluation Unit is designed as a convenient, low cost means of demonstrating the
capabilities of the MKN5610 OEM GPS receiver. The MKN5610 embeds the powerful ST
Microelectronics ST20GP6CX33 microprocessor providing GPS processing capability.

The Evaluation Kit contains the following components:

 MKN5610 OEM GPS Receiver

 MKN3910 Antenna (3M, SMA)

 Carrier PCB w/ Power Supply and Interface Jumpers

 AC Power Adapter (110AC)

 DC Power Adapter (12VDC CLA)
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4.2 Handling precautions

The Evaluation Kit contains components that are sensitive to electrostatic discharge. Please
handle with appropriate care.

Do not apply excessive force to mount or disassemble the MKN5610 from the Evaluation kit.

4.3 Power supply

 External supply: 6 to 15 VDC, at center contact. The system includes both a standard
AC wall adapter, and a DC cigarette lighter adapter.

 SRAM backup: 3V lithium CR2032

4.4 JTAG Interface

Your MKN5610 Evaluation Kit may be equipped with a JTAG interface for connecting with the ST
Connect programming box for reprogramming the GPS module. The Evaluation kit includes a 20
pin header for interfacing to this device on the end opposite of the connectors.

4.5 Basic Header H2

The MKN5610 communicates via the basic header H2 to the Evaluation unit. This is attached via
jumper cable to the Evaluation unit and allows communication to the serial ports.

4.6 Serial ports

The MKN5610 Evaluation box communicates through two serial ports configurable by the
following jumper settings :

4.6.1 Jumper DCE or DTE

Jumpers may be used to configure the DB9 data connectors for either DTE or DCE mode of
operation. The default setting is DCE, which allows the Evaluation box to communicate with a PC
using a standard serial cable.
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5. SOFTWARE –ADK VIEW

Mobile Knowledge has developed a PC based configuration tool allowing you to communicate
with the MKN5610. This software application is called ADKView.

5.1 Overview

The Application Design Kit (ADK) is a generic configuration and programming tool for Mobile
Knowledge GPS modules. It provides fully featured GPS configuration enabling selection of
NMEA strings, configuration of satellites and power management.

5.2 User Interface

There are six information display windows, as described in the following sub-sections:

5.2.1 NMEA Terminal Window

Figure 5.1 NMEA Terminal

Displays all messages output by the GPS device. The display is scrollable. To pause the display,
double-click with a mouse. The window title will indicate the paused status. To re-activate a
paused display double-click with a mouse. The paused status indication will be removed.

5.2.2 Satellite Signals Window

Figure 5.2 Signals

Presents a bar graph showing relative signal strength of all satellites the MKN5610 device can
see. The PRN of each satellite is indicated at the foot of the bar.
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A grey bar indicates a visible satellite for which there is no current ephemeris or from which the
signal strength is inadequate for use in position calculations.

A blue bar indicates a visible satellite that has signal strength adequate for use in position
calculations.

The height of the bar indicates the signal strength. A value is given at the top of the bar.

For each PRN the signal strength should be observed to be varying. When variation stops it is
because the satellite ephemeris has been lost and is being re-acquired. Variation will re-start
when the new ephemeris is successfully obtained, or the PRN will disappear from the display
after failure to reacquire.

5.2.3 Satellite Tracking Window

Figure 5.3 Satellites

Presents a graphical view of the azimuth and elevation of all visible satellites with reference to the
zenith and the horizon. The zenith is at the centre of the display, the horizon near the edges.

For each satellite the PRN, azimuth and elevation are given. Azimuth and elevation are in
degrees.

Satellites displayed in blue are being, or could be, used in position calculations.

5.2.4 Almanac Window

Figure 5.4 Almanac

Presents the parameters of the latest satellite almanac in memory.
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Thirteen values are displayed for each satellite in the whole constellation, as follows:

1. ID - The PRN of the satellite.
2. WK
3. Toa
4. E
5. Deltal
6. OmegaD
7. RootA
8. Omega0
9. Perigee
10. MeanA
11. Af0
12. Af1
13. H

5.2.5 Configuration Window

Figure 5.5 Configuration

Presents the details of the current configuration of the MKN5610 device.

5.2.6 Navigation Window

Figure 5.6 Navigation

Presents the details of the latest position calculation from the RMC message. This display will not
update if the RMC message display is turned off in Config/NMEA.

The display is not interactive.
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5.3 Pull Down Menus

The menu bar consists of seven items, descriptions of which follow.

5.3.1 File Menu

The first menu is the File menu. The File menu is intended for standard file operations, i.e. load,
save, print etc.

The File menu contains nine entries as follows.

Load Config

Presents a standard Open dialog box defaulting to opening ADK configuration files of type *.cfg.

Save Config

Presents a standard Save as… dialog box defaulting to saving ADK configuration files of type 
*.cfg.

Save As

Presents a standard Save as… dialog box defaulting to saving ADK configuration files of type
*.cfg.

Load Almanac

Presents a standard Open dialog box defaulting to opening almanac files of type *.alm.

Save Almanac

Presents a standard Save as… dialog box defaulting to saving almanac files of type *.alm.

Print

Gives access to standard printing functions.

Print Setup

Gives access to standard printing setup functions.

Exit

Closes the ADK program.

5.3.2 Comms Menu

The Comms menu contains entries involved in connecting and disconnecting from a GPS
MKN5610 device. The Comms menu contains three entries as follows.

Setup

Presents the Comms Setup window to allow the setting of port and speed values. The Comms
Setup window has two items :

Serial Port–select a communications port, from the presented list, for connecting to the GPS
MKN5610 device.

Baud–select a baud rate, from the presented list, for communication with the GPS MKN5610
device. The default rate is 4800.

Connect

Will attempt to connect the ADK program to the GPS MKN5610 device using the port and baud
values entered in Setup… above.

Disconnect

Will disconnect the ADK from the GPS MKN5610 device.
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5.3.3 GPS Menu

The GPS menu contains entries involved in the setup and configuration of the GPS MKN5610
device.

The GPS menu has seven items as follows.

Download Almanac from GPS

Sends the commands ‘$PSGM,GETALM,1’ to ‘$PSGM,GETALM,32’ to the GPS MKN5610 
device to obtain the almanac for every one of the 32 satellites.

Upload Almanac to GPS

Save Almanac to Flash

Clear Almanac

Sends the command ‘$PSGM,CLRALMS*6B’ to the GPS MKN5610 device to clear the almanac.

Clear Ephemeris

Sends the command ‘$PSGM,CLREPHS*76’ to the GPS MKN5610 device to clear the 
ephemeris.

Reboot GPS

Frequency Calibration…

5.3.4 Config

The Config menu contains entries involved in the configuration of the output data from the GPS
MKN5610 device. The Config menu has five items as follows.

Download from GPS

Sends the command ‘$PSGM,GETCONF*77’ to the GPS MKN5610 device to obtain the current
configuration of the device.

Upload to GPS

Sends the command ‘$PSGM,NMEA,000000000*3E’ to the GPS MKN5610 device to change the 
configuration of the device to that defined by the NMEA, General and Satellite Masking options
that follow.

NMEA

Presents the NMEA selection window with nine checkboxes, one for each NMEA sentence
produced by the GPS device. The sentences are GPGGA, GPGSA, GPGSV, GPRMC, GPVTG,
GPGLL, GPZDA, PSGMRAW and PSGMFIL. Check a checkbox to make the MKN5610 produce
the selected sentence. Uncheck a checkbox to suppress production of the selected sentence.

General
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Figure 5.7 GPS Configuration Screen

Presents the GPS Config window for the entry of assorted configuration values. These values
are:

 Earth Datum

Fix Mode

Select one from Auto, 2D or 3D

 Auto

 2D

 3D

Latitude

Entry of a latitude and longitude in this configuration window will give the GPS device an estimate
of its current position. This will greatly speed up acquisition of initial fixes on visible satellites.

Longitude

See Latitude above.

Altitude

Will set an initial estimate of current altitude.

Elevation Mask

This value indicates the satellite elevation below which the satellite will not be used for position
calculations even if they may be available and valid.

Pulse per Second

Check this checkbox to have the GPS MKN5610 device output an accurate timing pulse at the
rate of one per second.

Length
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Sets the length in milliseconds of the pulse output when the 'Pulse per second' checkbox above is
checked.

Port 1

 NMEA Output Rate sets the number of seconds between output of NMEA sentences.

 Baud Rate

Figure 5.8 Advanced Configuration Screen

Dilution of Precision

Sets the Dilution of Precision (DOP) threshold above which the receiver will indicate a poor
position fix.

 2D PDOP

 2D HDOP

 2D VDOP

 3D PDOP

 3D HDOP

 3D VDOP



Port 2

 DGPS Mode

 Baud Rate

 Debug Output - check this checkbox to cause debug information to be sent out from port
2.

Satellite Masking

Presents the Satellite Masking window. This window has a checkbox for each of the 32
satellites, which could potentially be visible.

 Check a checkbox to enable tracking of a particular satellite.

 Uncheck a checkbox to disable tracking of a particular satellite.
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5.3.5 View Menu

The View menu contains standard functions for the user interface windows and tool bars.

5.3.6 Window Menu

The Window menu contains the standard windows layout functions. Tiling the windows will re-
display the windows in the reverse order in which they last had focus, starting at top left, going
down and ending at bottom right.

5.3.7 Help Menu

The Help menu contains the standard Help features.

5.4 Stored Parameters

The following parameters are stored in the MKN5610's flash:

5.4.1 Almanac

 Satellite’s PRN

 Week number for the epoch

 Satellite PRM

 Shift-left test result

 Eccentricity

 Rate of inclination angle

 Rate of right ascension

 Square-root of semi-major axis

 Longitude of ascending node of orbit plane at weekly epoch

 Argument of perigee

 Mean anomaly at reference time

 Constant clock correction

 First order clock correction

 Satellite health

 Satellite availability

5.4.2 Position

 Longitude and Latitude

 Altitude

The almanac and position data stored in flash are used to acquire a fast satellite lock following a
cold start, when the battery-backed almanac will have been lost.
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APPENDIX A–SUPPORT

For ordering information, contact:

Mobile Knowledge Inc.
84 Hines Road
Kanata, Ontario, Canada, K2K 2M5
Phone: 1-613-271-1601
Fax: 1-613-271-9827
e-mail: info@Mobile-Knowledge.com
web: www.Mobile-Knowledge.com

If you encounter any difficulty in working with the MKN5610 Evaluation Kit, please contact Mobile
Knowledge technical support between 08:30 to 17:00 Eastern time:

Tel: 1-613-271-1601
Fax: 1-613-271-9827
e-mail: info@Mobile-Knowledge.com
web: www.Mobile-Knowledge.com


